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1 OVERVIEW
This document is intended as a reference for you if you have a specific question or find any difficulty.  You will NOT necessarily go from screen to screen. What you see will depend upon the choice you made when starting out each time.  If you choose to use your browser you will see a different view on the screen than if you start using web folders.  This is a work in progress and this document will be updated as feedback arrives.  While using the program, please share your acquired knowledge with the team by sending your comments, ideas, and questions to willilam.ctr.doble@faa.gov. 

2 GETTING STARTED
2.1 Requirements for Accessing the System

The minimum requirements for accessing the Collaborative Communications System (CCS) are:

· Netscape 4.75 or Internet Explorer 4.0
 Web browser or higher

· Microsoft Windows 2000 operating system

· Microsoft Office 2000

· A user ID and password

In order to use the Web folders option in the system you will also need to install the SharePoint Portal Server client software that is provided by your SharePoint Administrator.  Microsoft recommends the following minimum configuration to run the client software:

· A system with a Pentium-compatible 200 MHz or higher processor,

· At least 64 MB of RAM, and

· At least 30 MB of available hard-disk space.

The CCS does not offer the same functionality through its browser and Web folder interfaces.  The browser interface gives the user access to the document repository including search and subscription capabilities but not administrative features.  The Web folder interface is primarily meant to provide access to the document repository and administrative features.  It does not have the search and subscription capabilities.

2.2 Browsers

To begin accessing the CCS through your browser, go to the AUA-700 Web site CCS page at http://www.faa.gov/aua/aua700/tools/ccsystem/ccsystem.shtml. Click on the link that reads Go to the Collaborative Communications System as shown in Figure 2.2.1.  This will open a new browser window, prompt you for your user ID and password as shown in Figure 2.3.5, and take you to the CCS Home page where you can select from a variety of topics.  
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Figure 2.2.1:  AUA-700 Web site’s Collaborative Communications System page

The CCS’s Home page is shown in Figure 2.2.2.
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Figure 2.2.2:  The CCS Home page

2.3 Web Folders:

A Web folder is a shortcut to a Web server.  To begin accessing the CCS through the Web folders option, 

· Go to your Windows Explorer. 

· Select the folder called “My Network Places” as shown in Figure 2.3.1.  (This is also an icon on your Windows desktop.)  From here, you will add a Network Place.  

· Double-click on the “Add Network Place” icon. 

This will take you through a series of steps, beginning with the dialog shown in Figure 2.3.2, for creating a Web folder to access the CCS and its document repository.
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Figure 2.3.1:  “My Network Places” folder in Windows Explorer

Enter the URL “http://kms.faa.gov/AUA-700Workspace” (without quotes) as the location for the Network Place as shown in Figure 2.3.2, and push the Next button.
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Figure 2.3.2:  Specifying the URL for the new Web folder

Enter the name for the Web folder.  (“AUA-700 Workspace on kms.faa.gov” in the example given in Figure 2.3.3.)  Push the Finish button, and a new Web folder will appear in your “My Network Places” in Windows Explorer.
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Figure 2.3.3:  Specifying the name of the new Web folder

You access the CCS by double-clicking on the icon just created in your “My Network Places” folder. 
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Figure 2.3.4:
“My Network Places” folder in Windows Explorer with a new Web folder title

In the example in Figure 2.3.4, double-click on the icon labeled “AUA-700 Workspace on kms.faa.gov”.  This will show the dialog in Figure 2.3.5 where you enter your user ID and password for the CCS.
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Figure 2.3.5:  CCS login dialog

Once you have successfully logged in to the CCS’s Web folder interface, you will see many of the folders shown in Figure 2.3.6.  The document repository is the Documents folder.
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Figure 2.3.6:  The CCS’s Web folders interface

3 DOCUMENT MANAGEMENT:
The CCS offers a centralized repository for storing, collaborating on, and managing documents and sharing information.  This repository is just like the folders that you see in your Windows Explorer (see the example in Figure 3.1).  Documents are stored in folders, and subfolders can be created within folders.
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Figure 3.1:  A folder in the Document repository as viewed through Windows Explorer

The Document Repository seen in Figure 3.2 can also be accessed via the Web by clicking on the Document Library link and then the Documents link within the CCS.
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Figure 3.2:  Document repository as viewed through Internet Explorer

Each folder has at least one user designated as the Coordinator who gives users access to the folder and assigns them a role that determines their privileges.  Privileges determine a user’s ability to create subfolders and add or modify documents within a folder.  A user with read-only privileges in a folder is only able to view published and approved documents in that folder.  A user with write privileges in a folder is able to view and edit the most current version of all documents in that folder and create subfolders.

The CCS has two kinds of folders:  Standard and Enhanced.  

· Standard: Documents added to or modified in a Standard folder are immediately available to everyone with access to the folder, and only the latest version of a document is stored.  

· Enhanced: Documents added to or modified in an Enhanced folder must go through an approval process before they become available for viewing by users with read-only privileges.  These documents are immediately available to those with write privileges in the folder.  Multiple versions of a document in an Enhanced folder are stored, one for each time a user changes a document.
A document’s associated icon indicates what actions are being performed on it in an Enhanced Folder.  

· In Figure 3.3, the document “Test Excel Worksheet” with the [image: image11.png]


 icon has been modified and is awaiting approval to have the updates made available to everyone.  

· A user is currently editing the document “Test Word Document” with the [image: image12.png]


 icon in Figure 3.3.  

· The document “Test Text Document” with the [image: image13.png]


 icon in Figure 3.3 has been approved and is available for everyone to view.  

· If only the document’s application icon is shown, the document is available to be checked out for further modifications or started through its review and approval process.


[image: image14.wmf] 


Figure 3.3:  Documents in an Enhanced folder

4 ADDING/MODIFYING DOCUMENTS (VIA WEB FOLDERS)
4.1 Enhanced Folders

4.1.1 Check Out

To edit a document in an Enhanced folder, you must first check it out.  Checking out a document means that you are securing for yourself the right to exclusively modify it.  If you check out a document, no one else can modify it until either you check it in or undo your check out of the document.  Select the Check Out command from the File menu as shown in Figure 4.1.1. 
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Figure 4.1.1:  Checking out the “Test Text Document” document for editing in an Enhanced folder

4.1.2 Undo Check Out

After checking out a document, if you determine that you are not going to actually make modifications to it, you can undo the check out and make the document available for changes by other users.  Do this by selecting the Undo Check Out command from the File menu as shown in Figure 4.1.2.
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Figure 4.1.2:  Undoing the check out the “Test Text Document” document in an Enhanced folder

4.1.3 Check In

After checking out a document you can then edit it by double-clicking on its icon or selecting the Open command from the File menu.  When you are finished making your modifications and want to have the changes reviewed, you must check in the document.  Select the Check In command from the File menu as shown in Figure 4.1.3.  
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Figure 4.1.3:  Checking in the “Test Text Document” document in an Enhanced folder

When you check in a document, you are asked to provide a short description of the changes made as shown in Figure 4.1.4.  At this time, you can also modify any of the document’s profile information that describes the document itself (e.g. title, author, keywords, description).  It is good to be in the habit of entering version comments whenever a document is checked in.  It will make it easier to understand the changes made in a particular version of a document at a later time.  
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Figure 4.1.4:  Version comments for the changes made to the “Test Text Document” document

4.1.4 Publish

After the document has been checked in and if no other modifications need to be made, select the Publish command from the File menu as shown in Figure 4.1.5 to start the review and approval process [or you could check the “Publish this document after check-in” box in Figure 4.1.4].  (The Review and Approval process is discussed in detail in the Document Review section.)
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Figure 4.1.5:  Submitting the changes to the document for review in an Enhanced folder

You can add a new document by dragging it into an Enhanced folder.  Doing this creates the document in the folder and keeps the file checked out.  You then need to follow the instructions in this section for checking in and publishing a document in an Enhanced folder.

5 VIEWING A DOCUMENT’S VERSION HISTORY
The version history of a document is the list of all changes that users have made to the document.  (A change to a document is defined as all the modifications made prior to checking it in to the CCS.)  The CCS only maintains a version history for those documents in Enhanced folders.

5.1 Via Web Folder

To view the version history of a document using Web folders, select the document’s icon and choose the Properties command from the File menu as shown in Figure 5.1.1.  (All of the Web folder’s File menu commands discussed is also available in the pop-up menu displayed when you click the right mouse button on a document’s icon.)  
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Figure 5.1.1:  Viewing the properties of a document

In the Properties dialog, choose the Versions tab as shown in Figure 5.1.2.
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Figure 5.1.2:  Viewing the Versions tab of a document’s properties

The Document versions section of the dialog in Figure 5.1.2 lists the version history of the document.  You can select an individual version number and see the associated comments on the changes made, document’s profile, or actual document.

6 SEARCHING FOR DOCUMENTS:
The CCS provides the ability for you to perform a case insensitive, full-text search of its document repository (both text and profile information) as well as external document sources for keywords specified through its browser interface.  You can enter the criteria as a simple text string (i.e., a Simple Search) or as a text string and/or criteria for specific document profile fields (i.e., an Advanced Search).  The Search option is available at the top of the CCS’s main pages (e.g., Home, Search, Categories, and Document Library).  Click on the Search link.

6.1 Simple Search

The default search option is the Simple Search as shown in Figure 6.1.1.  You enter a text string and push the Go button. The CCS then searches through its documents’ text and profile information for those that contain at least one word in the search string.  In this example, documents that contain either the word “excel” or “notepad” in their text or profile information will be listed in the search’s results.  
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Figure 6.1.1:  Simple Search page

From a Simple Search, you can go to an Advanced Search by clicking on the Advanced search link as seen at the top of the page in Figure 6.1.1.

6.2 Advanced Search

The Advanced Search allows you to more precisely define the criteria for the search to be executed and to narrow the search results.  You can still enter a text string for searching the documents’ text and profile information.  However, you can also enter criteria against specific document profile fields as shown in Figure 6.2.1.  In addition, you can also specify criteria on when the document was created or last modified.  In this example, the search from Figure 6.1.1 is further refined for only those documents whose author profile field contains the word “Microsoft”.  
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Figure 6.2.1: Advanced Search page

From an Advanced Search, you can go to a Simple Search by clicking on the Simple search link as seen at the top of the page in Figure 6.2.1.

7 SUBSCRIBING TO DOCUMENTS 
Subscriptions notify you about new or updated information on topics that match your interests. You can subscribe to content you find useful: a specific document, all documents in a folder, all documents assigned to a category, or a set of search results. After you subscribe to content, the CCS notifies you when the content is modified, if a new document matching your criteria is available, or if Web discussion comments about the content are added.  You can also choose to receive subscription notifications by e-mail.

7.1 Via Office 2000

You subscribe to a folder or document from the Office 2000 interface by first opening a Web discussion for the document by selecting the Web Discussions command in the Online Collaboration pop-out menu available from the Tools menu and pushing the Subscribe button in the resulting Discussion toolbar.  (A more in-depth look at Web discussions occurs in the Discussing Documents section.)  This displays the dialog shown in Figure 7.1.1.
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Figure 7.1.1:  Document Subscription dialog

You use the Document Subscription dialog to specify: 

· the file or folder for which the subscription is to be created,

· the event that triggers the subscription notification,

· the e-mail address where the notification is to be sent, and 

· the frequency of the subscription notifications.

The file defaults to the current document being edited.  The folder defaults to the current document’s folder.  The events that trigger a notification for a subscription are shown in Figure 7.1.2.  The frequencies of subscription notifications are the same as for the browser interface.  Finally, the e-mail address is required.  Push the OK button in the dialog to actually create the subscription.
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Figure 7.1.2:  Events that trigger a subscription notification

Figure 17.1.9 shows an example of an e-mail notification sent by the CCS as the result of a subscription.  You can click on the link that is the document title to view the document, go to the subscription Web page, or delete the subscription.

8 DISCUSSING DOCUMENTS
You can conduct online discussions about a document without modifying the document. Instead of using e-mail to discuss a document or trying to capture conversations about a document, authors and reviewers can now communicate with each other through Web discussions.   These discussions can occur through browser or Office 2000 interfaces.  Simultaneous discussions about a document can occur even if one person has the document checked out. Comments are stored as threaded conversations, grouping comments and replies together.

8.1 Via Office 2000

You participate in a Web discussion for a document by selecting the Web Discussions command in the Online Collaboration pop-out menu available from the Tools menu.  The Office 2000 application’s window is split with the document appearing in the top pane of the window and the actual discussion appearing in the bottom pane as shown in Figure 8.1.1.  The Reply, Edit, and Delete commands for a comment function the same as in the browser interface.
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Figure 8.1.1:  Web discussion in Office 2000 for the “Test Word Document.doc” document

The Discussions button in the toolbar at the bottom of the screen in Figure 8.1.1 gives you the following options: 

· Insert in the Document

· Insert about the Document

· Refresh Discussions

· Filter Discussions

· Print Discussions

The Insert in the Document and Insert about the Document commands are very similar.  Both allow you to create new topics of discussion, but the former one creates the discussion and makes it accessible via a [image: image27.wmf] icon within the body of the document.  (This kind of discussion is not supported in the browser interface.) The latter command functions like the Insert Discussion button in the browser interface.  The Refresh Discussions command updates the discussion topics and comments based on any input from other users.  The Filter Discussion command works like the Filter button in the browser interface.  The Print Discussions command allows you to print out the discussions associated with a document.  The Discussion Options command functions like the View button in the browser interface and displays the dialog shown in Figure 8.1.2.
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Figure 8.1.2:  Discussion Options dialog

In the Discussion Options dialog, you can add or edit a discussion server that displays the dialog shown in Figure 8.1.3.  The name of the discussion server should be kms.faa.gov.  You can type in your own name in the other edit field in the dialog.
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Figure 8.1.3:  Discussion Server dialog

9 DOCUMENT REVIEW
A Coordinator for an Enhanced folder can specify a review and approval process for documents within the folder.  (Setting up an approval process is discussed in the Document Administration section.)  When it is time for a user to review a document, he/she can receive an e-mail notification about the document to review.  Figure 9.0.1 shows an example of a document review e-mail notification sent by the CCS.  From this e-mail, you can review the document by clicking on the link that is the document’s name or go directly to the Document Inspection page to approve or reject the document by clicking on the Click here to approve or reject this document link.
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Figure 9.0.1:  Sample document review e-mail notification

9.1 Via Browser

To review a document, click on its associated Show Actions link shown in Figure 9.1.1 to display its Document Inspection page.
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Figure 9.1.1:  Clicking the Show Actions link as part of reviewing the document

9.1.1 Approve

Click on the Approve link on the Document Inspection page as shown in Figure 9.1.2 to approve the changes.  This displays the confirmation dialog shown in Figure 9.1.3.  Pushing the OK button will actually approve the document and advance it to the next step in the review and approval process.  (The remaining approvers for a document are shown at the bottom of the Document Inspection page.)  Pushing the Cancel button will leave the document assigned to you for review.
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Figure 9.1.2:  Approving the latest modifications to the document
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Figure 9.1.3:  Confirmation dialog to approve changes to a document

9.1.2 Reject

Click on the Reject link on the Document Inspection page as shown in Figure 9.1.4 to reject the changes.  This displays the confirmation dialog shown in Figure 9.1.5.  Pushing the OK button will actually reject the document and stop the review process; however, the changes made to the document will remain and not be undone.  Pushing the Cancel button will leave the document assigned to you for review.
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Figure 9.1.4:  Rejecting the latest modifications to the document
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Figure 9.1.5:  Confirmation dialog to reject changes to a document

9.2 Via Web Folder

9.2.1 Approve

Click the right mouse button and select the Approve command from the pop-up menu as shown in Figure 9.2.1.  (This is the same as selecting the Approve command from the File menu.)  This approves the document and advances it to the next step in the review and approval process.

[image: image36.png]| Fie et vew Fovortes Toos Help

J

EBak v S -

Qsearch Tyroders (ristory | 25 05 X 00|

Address

I
[

Documents

Name

Document State ~

Modfied

Author

e e Wordcocument
(yrest Text bocument

Open
New
Print

=
e
e
i
o

€ Tew icrosof e Worahest Checledin

Checked-Out
Checked-Out
Pending approval
Pending approval
Publihed
Pending approval

9/10/2001 12:10 M
9/10/2001 12:31 PM
917/2001 7:22 M
917/2001 3:17 M
9102001 12:20PM
9112001 3:12 PM
9113(2001 330 PM
912/2001 10:28 AM
912(2001 8:13 AM

I

Micrasoft Cor.
TRW USER
wiliam
Micrasoft Cor.

TRW
Micrasoft Cor.

New war:
Testtext
Test Exce

NIAA





Figure 9.2.1:  Approving the latest modifications to the “William New Excel Worksheet.xls” document

9.2.2 Reject

Click the right mouse button and select the Reject command from the pop-up menu as shown in Figure 9.2.2.  (This is the same as selecting the Reject command from the File menu.)  This stops the review process; however, the changes made to the document will remain and not be undone.
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Figure 9.2.2:  Rejecting the latest modifications to the “William New Excel Worksheet.xls” document

9.2.3 Bypass Approval

This command is only available to users that are designated as Coordinators for a folder and can be executed at any time during the review and approval process.  Click the right mouse button, and select the Bypass Approval command from the pop-up menu as shown in Figure 9.2.3.  (This is the same as selecting the Bypass Approval command from the File menu.)  This skips the approval process, automatically approves the new version of the document, and makes it available to all users with access to the folder.
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Figure 9.2.3:  Bypassing the approval of the latest modifications to the document

9.2.4 Cancel Publishing

This command is only available to users that are designated as Coordinators for a folder and can be executed at any time during the review and approval process.  Click the right mouse button, and select the Cancel Publishing command from the pop-up menu as shown in Figure 9.2.4.  (This is the same as selecting the Cancel Publishing command from the File menu.)  This stops the approval process and is equivalent to a reviewer rejecting the changes to a document.
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Figure 9.2.4:  Canceling the review/approval process for the latest modifications to the document

10 CONTACT LIST
This list contains contact information (e.g., address, e-mail, and phone) for a group of users.  To display a summary of the contact information, click on the Contact List link in the Quick Links section of the CCS Home page as shown in Figure 10.1.  This opens the Contact List page in a separate browser window.
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Figure 10.1:  Accessing the Contact List from the CCS Home page

The default view for the Contact List is a summary of the contact information as shown in the example in Figure 10.2.  However, there are multiple ways to view the contact list as seen in the View dropdown list box in Figure 10.2.  
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Figure 10.2: Summary contact list

To edit one entry in the list, click on the link that is the contact’s name seen in Figure 10.2.  This will display the detailed information from Figure 10.3 for the selected user.  To add a new contact to the list, click on the New link shown at the top of the page in Figure 10.2.  This will open a new page with all of the detailed contact fields in Figure 10.3 blank.  Enter all the requested information and click on the Save and Close link at the top of the page. This form also allows for printing and deleting of the information.
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Figure 10.3:  Detailed contact information

11 GROUP CALENDAR
The Group Calendar shows events that are not assigned to a specific person but are applicable to a group of people.  To access the Group Calendar, click on the Group Calendar link in the Quick Links section of the CCS Home page as shown in Figure 11.1.  This opens the Group Calendar in a separate browser window.
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Figure 11.1:  Accessing the Group Calendar from the CCS Home page

You can view the calendar by day, week or month.  Figure 11.2 shows the monthly view of the calendar.  To edit an event in the calendar, double-click on its title.  This will display the detailed information from Figure 11.3 for the selected event.
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Figure 11.2:  Group calendar page (monthly view)

To add a new event to the calendar, click on the New link shown at the top of the page in Figure 11.2.  This will open a new page with all of the detailed event fields in Figure 11.3 blank.  Enter a Subject, Location, Start and End Time and a message in the text box. 
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Figure 11.3: Detailed calendar event information

If the event is recurring, click on the Recurrence link at the top of the page shown in Figure 11.3, and enter the recurrence pattern (see Figure 11.4).  Click on the Save and Close link at the top of the page shown in Figure 11.3 to save the event to the calendar.
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Figure 11.4:  Entering the recurrence pattern for an event

12 NETMEETING AND CONFERENCING
The CCS provides links on its Home page to schedule and join conferences.  See Figure 12.0.1 for the Schedule a Conference and Join a Conference links in the Quick Links section of the page.
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Figure 12.0.1: Conferencing links on the CCS Home page

12.1 Scheduling a Conference

Click on the Schedule a Conference link in the Quick Links section of the CCS Home page.  This takes you to the page shown in Figure 12.1.1.  
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Figure 12.1.1: Your Microsoft Exchange inbox

Click the New button at the top of the page and select the Appointment option that appears in the resulting dropdown menu as shown in Figure 12.1.2.
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Figure 12.1.2:  Scheduling a conference by sending an e-mail appointment to all attendees

Scheduling a conference involves sending an e-mail appointment to a special user account called “conference”.  Enter the e-mail addresses of all attendees (including “conference”); specify the date/time of the conference; and enter a subject to describe the purpose of the conference.  (You can either separate the e-mail addresses with a semi-colon or push the Save button after entering each address.)  Push the Send button at the top of the page to actually schedule the conference.  An example is shown in Figure 12.1.3.
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Figure 12.1.3:  Entering information about the conference to be scheduled

When the conference has been scheduled, you will receive a confirmation e-mail message on the page shown in Figure 12.1.1.  (See Figure 12.1.4.)
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Figure 12.1.4:  Reply to request to schedule a conference

The contents of this confirmation e-mail message are shown in Figure 12.1.5. 
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Figure 12.1.5:  Confirmation e-mail message of scheduled conference

12.2 Joining a Conference

Click on the Join a Conference link in the Quick Links section of the CCS Home page.  This takes you to a page like the one shown in Figure 12.2.1.  
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Figure 12.2.1: Listing of all the current and upcoming conferences

When it is time for the conference to occur, click on the link in Figure 12.2.1 that is the name of the conference you previously created (“Test Conference” in this example).  This shows the page displayed in Figure 12.2.2.  This is the page where the conference occurs.  You need Internet Explorer and at least NetMeeting version 3.01 installed on your computer to participate in a conference.
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Figure 12.2.2:  Conference page

At the bottom of the page in Figure 12.2.2 is a list of attendees and four buttons.  From left to right, the buttons are for sharing an application/desktop, chatting, drawing on a whiteboard, and sending a file.  Each of these is discussed in more detail in the subsequent sections.

12.2.1 Share an Application/Desktop

One of the options in a conference is to share one of the applications running on your computer or your entire desktop with the other attendees.  Doing this means that all the other attendees will have access to your application or desktop.  In Figure 12.2.3, you specify the item to be shared (i.e., an application or your entire desktop) and whether or not you will allow anyone to take control of the application or desktop.  “Taking control” means that someone can assume control of your application or computer and perform actions as if you were doing them.
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Figure 12.2.3:  Sharing an application or desktop

For this example, assume that User A shares his/her entire desktop with all the conference attendees and allows other users to take control of the desktop.  All others attendees see a window like the one shown in Figure 12.2.4, the shared desktop of User A.  You can take control of that desktop by double-clicking the mouse and then manipulate anything on the desktop (e.g., run an application or edit a file).  User A can retake control of the desktop by double-clicking his/her mouse again.
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Figure 12.2.4:  Window for sharing another conference attendee’s desktop

“Sharing” can be one way to have multiple users simultaneously work and collaborate on the same document.  

12.2.2 Chat

You can exchange text messages with all other conference attendees in a group chat room as shown in Figure 12.2.5.  Enter the text to send in the Message field and push the button next to that field.
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Figure 12.2.5: Conference attendees chatting

12.2.3 Draw on a Whiteboard

In a conference, you can also draw pictures on a shared whiteboard.  In the example shown in Figure 12.2.6, one user in a conference drew the two horizontal lines at the top of the page, and another drew the solid box at the bottom on the page.  Each conference attendee saw just one whiteboard on which both users made their drawings.
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Figure 12.2.6:  Drawing on a shared whiteboard

12.2.4 Send a File

Conference attendees can send files to each other.  In Figure 12.2.7, you select the Add Files command from the File menu and choose the files from your local hard drive using the standard Windows file dialog.
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Figure 12.2.7:  Selecting files to send to another conference attendee

When the files have been specified, select the Send All or Send A File command from the File menu to send the file(s) to the specified users.  See Figure 12.2.8 for an example.
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Figure 12.2.8: Sending files to another conference attendee

Additional Features

13 MODIFYING DOCUMENTS (VIA A BROWSER):
13.1 Enhanced Folders:

To edit a document in an Enhanced folder, you must first check it out.  Checking out a document means that you are securing for yourself the right to exclusively modify it.  If you check out a document, no one else can modify it until either you check it in or undo your check out of the document.  Click the Show Actions link for the document that is to be modified as shown in Figure 13.1.1.
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Figure 13.1.1:  Clicking the Show Actions link as part of editing document in an Enhanced folder

13.1.1 Check out

Click the Check Out link on the Document Inspection page as shown in Figure 13.1.2. Notice that the current draft version of the “Test Text Document” document is 1.2 in this example.  
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Figure 13.1.2:  Clicking the Check Out link as part of editing the document in an Enhanced folder

Click with the right mouse button on the link that is the document’s title and select the Save Target As command (Save Link As if you are using Netscape) in the pop-up menu as shown in Figure 13.1.3 to save this version of the document to your local hard drive.  Edit the document from your hard drive.
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Figure 13.1.3:  Saving the “Test Text Document” document to your local hard drive

Push the Ok button on the Check out a document page as seen in Figure 13.1.3 to return to the Document Inspection page.  Now, the current working copy version of the “Test Text Document” document is 1.3 and the status indicates that it is checked out as shown in Figure 13.1.4.  
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Figure 13.1.4:  Document Inspection page when the “Test Text Document” is checked out

13.1.2 Undo Check Out

After checking out a document, if you determine that you are not going to actually make modifications to it, you can undo the check out and make the document available for changes by other users.  Do this by clicking the Undo Check Out link on the Document Inspection page as shown in Figure 13.1.5.
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Figure 13.1.5:  Clicking the Undo Check Out link for the document in an Enhanced folder

13.1.3 Check in

When you are finished making your modifications and want to have the changes reviewed, you must check in the document.  Click on the Check In link on the Document Inspection page as shown in Figure 13.1.6.
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Figure 13.1.6:  Clicking the Check In link as part of editing the document in an Enhanced folder

Next, enter the path and name of the document from your hard drive that you were editing as shown in Figure 13.1.7 (If you push the Browse button, you can use the standard Windows file dialog to select the document on your hard drive.) and push the Continue button.  
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Figure 13.1.7:  Entering the path/name of modified file when updating document in Enhanced folder

Finally, you can provide a short description of the changes made and enter meta data or profile (e.g. title, keyword, author, description) information for the document as shown in Figure 13.1.8.  This information describes the document.  It is a good idea to be in the habit of entering version comments whenever a document is checked in.  It will make it easier to understand the changes made in a particular version of a document at a later time.
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Figure 13.1.8:  Entering profile information about the document updated in an Enhanced folder

13.1.4 Publish

After the document has been checked in, click on the Publish link on the Document Inspection page as shown in Figure 13.1.9 to start the review process for the document.  (The Review and Approval process is discussed in detail in the Document Review section.)
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Figure 13.1.9:  Clicking Publish link to submit changes to document for review in Enhanced folder

After clicking on the Publish link, you then must in the resulting dialog box confirm that you want to submit the document for review and approval by pushing the OK button as shown in Figure 13.1.10.  Pushing the Cancel button will cause the document not to be submitted for review.
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Figure 13.1.10:  Confirming submitting the changes to a document for review in an Enhanced folder

14 Adding Documents (via a Browser)

To add a new document to a folder, click on the Add Document link in that folder as shown in Figure 14.1.1.
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Figure 14.1.1:  Clicking the Add Document link to add a new document to a folder

You will then be prompted to specify the path and name of the new document.  The Add a Document page looks slightly different depending on whether the document is being added to a Standard or Enhanced folder.  This page for an Enhanced folder is shown in Figure 14.1.2.  If you choose the Check in the document option and push the Continue button, the new document will be checked in and added to the folder but will not start the review and approval process.  If the Publish the document option is chosen, the new document will be checked in and added to the folder, and the review and approval process for the document will automatically be started.
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Figure 14.1.2:  Entering path/name of the local file when adding new document to Enhanced folder

The Add a document page for a Standard folder is shown in Figure 14.1.3.
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Figure 14.1.3:  Entering path/name of the local file when adding new document to Standard folder
After you push the Continue button on the Add a document page, the page in Figure 14.1.4 is shown.  This allows you to enter version comments and profile information for the new document.  (The version comments are not available when adding a new document to a Standard folder.)
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Figure 14.1.4:  Entering profile information for a new document

15 ADDING/MODIFYING DOCUMENTS (VIA OFFICE 2000):
15.1 Standard Folders
To edit a document in a Standard folder using Office 2000, select the Open command in the File menu of the Office 2000 application and navigate to the Web Folder containing the document to be modified as in the example shown in Figure 15.1.1.
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Figure 15.1.1:  Navigating to document to be edited in Standard folder using Office 2000 file dialog

Once the document has been opened, you simply modify it as if it were on your local hard drive.  When you save your changes, you will see a dialog like the one shown in Figure 15.1.2 indicating that the Office 2000 application is saving the document back to the Standard folder in the CCS.
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Figure 15.1.2:  Dialog indicating that the Office 2000 application is saving changes to the document

To add a new document to a Standard folder, simply save the new file to the desired Web folder.

15.2 Enhanced Folders
To edit a document in an Enhanced folder using an Office 2000 application, you must already have checked out the document.  At this point, you open and edit the document as described for Standard folders. 

When you are finished making your modifications and want to have the changes reviewed, you must check in the document.  Select the Check In command from the File menu of the Office application.  After the document has been checked in, select the Publish command from the File menu to start the review process for the document’s changes. You can add a new document to an Enhanced folder by simply saving it to the desired Web folder.  Doing this creates the document in the folder and keeps the file checked out.  You then need to follow the instructions in this section for checking in and publishing a document in an Enhanced folder.

16 VIEWING A DOCUMENT’S VERSION HISTORY
16.1 Via Browser

To view the version history of a document using a browser, click on the document’s associated Show Actions link as shown in Figure 16.1.1.
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Figure 16.1.1:  Clicking Show Actions link for the document when viewing its version history

Next, click the Version History link on the resulting Document Inspection page as shown in Figure 16.1.2.  
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Figure 16.1.2:  Clicking Version History link for document when viewing its version history

The Version history page shown in Figure 16.1.3 lists all of the document’s versions and each associated comment.  If you click on the version numbers, the actual document associated with that version is displayed.  Push the Ok button to return to the Document Inspection page.
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Figure 16.1.3:  Viewing the Version history page for the “Test Excel Worksheet” document

17 SUBSCRIBING TO DOCUMENTS

17.1 Via Browser

You subscribe to a folder or document from the browser interface by clicking on its associated Subscribe link as shown in the example in Figure 17.1.1 where a subscription is being created to the “Team folder” folder.
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Figure 17.1.1:  Subscribing to the “Team folder” folder

You subscribe to search results by clicking on its associated Subscribe to this search link as shown in the example in Figure 17.1.2 where a subscription is being created to the results of the search for “excel notepad”.
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Figure 17.1.2:  Subscribing to search results

You subscribe to all the documents in a category by clicking on its Subscribe to this category link as shown in the example in Figure 17.1.3 where a subscription is being created to the category Category1.  (A category is an alternative way to organize documents in the repository.)
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Figure 17.1.3:  Subscribing to the Category1 category

The subscription is not actually created until you push the Ok button on the New subscription page as shown in Figure 17.1.4.  You can optionally choose to be notified via e-mail when a document associated with a subscription is modified or created and specify how frequently you want to be notified about your subscriptions.
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Figure 17.1.4:  Specifying e-mail notification information for a subscription

You can go to the CCS Home page to see your subscriptions and any notifications of documents associated with the subscriptions that have been modified or added.  In the example in Figure 17.1.5, the Subscription Summary section of the page shows that the “Test Word Document” has been updated; and “Share Text Document” has been added to the “Team folder” folder.
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Figure 17.1.5:  The CCS Home page showing a user’s subscriptions

Click on the Subscriptions link at the top of the page.  This takes you to a page for maintaining your subscriptions.  As shown in Figure 17.1.6, you can clear a notification for a specific document by clicking on its associated Clear link, and you can clear all the notifications for a subscription by clicking on the subscription’s Clear all notifications link.  You can delete a subscription by clicking on its Delete subscription link, and you can delete all your subscriptions by clicking on the Delete all subscriptions link at the top of the page.
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Figure 17.1.6: The CCS Subscriptions page for maintaining a user’s subscriptions

When you try to delete a subscription, you are prompted to confirm this action.  Figure 17.1.7 shows the confirmation dialog you will see when trying to delete a subscription.  Push the OK button to have the CCS delete the subscription and Cancel to abort the operation.
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Figure 17.1.7:  Confirmation dialog to delete a subscription

Figure 17.1.8 shows the confirmation dialog you will see when trying to delete all of your subscriptions.  Push the OK button to have the CCS delete all your subscriptions and Cancel to abort the operation.
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Figure 17.1.8: Confirmation dialog to delete all subscriptions

Figure 17.1.9 shows an example of an e-mail notification sent by the CCS as the result of a subscription.  You can click on the link that is the document title to view the document, go to the subscription Web page, or delete the subscription.
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Figure 17.1.9: Sample subscription e-mail notification

18 DISCUSSING DOCUMENTS

18.1 Via Browser: 

You participate in a Web discussion for a document by clicking on its associated Discuss link as shown in Figure 18.1.1.
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Figure 18.1.1:  Clicking the Discuss link for a document when contributing to a Web discussion

During a Web discussion, the browser window is split with the document appearing in the top pane of the window and the actual discussion appearing in the bottom pane as shown in Figure 18.1.2.  There can be multiple topics of discussion within the document.  For each topic, there can be many comments by multiple users.  The Close button at the bottom of the page closes the discussion pane leaving only a window displaying the document.
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Figure 18.1.2:  Web discussion in a browser for the “Test Word Document.doc” document

To create a new discussion topic, push the Insert Discussion button at the bottom of the page shown in Figure 18.1.2.  This opens the window shown in Figure 18.1.3.  You enter the discussion topic (e.g., “First discussion topic about this test Word document”) in the Discussion Subject field and your optional, initial comments on the topic (e.g., “These are William’s comments on this subject.”) in the Discussion Text field.  Push the OK button to actually create the topic.  

When a comment is entered on a discussion topic, icons appear next to it.  Clicking on a [image: image91.png]


 icon allows you to reply to the comment.  Clicking a [image: image92.png]


 icon allows you to edit the comment.  Clicking a [image: image93.png]


 icon allows you to delete the comment.
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Figure 18.1.3:  Creating a new discussion topic for a document

The display in the bottom pane of the window in Figure 18.1.2 can be customized.  Pushing the View button displays the window shown in Figure 18.1.4.  Unchecking the Author field and pushing the OK button hides the “From:” line for a comment.  Unchecking the Text field and pushing the OK button hides the actual comments by the author.  Unchecking the Subject field and pushing the OK button hides the “Subject:” line of the discussion topic.  Finally, unchecking the Time field and pushing the OK button hides the date/time displayed at the far right of the comment.
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Figure 18.1.4:  Options for customizing the information displayed in a Web discussion

The comments displayed in the bottom pane of the window in Figure 18.1.2 can also be filtered.  Pushing the Filter button displays the window shown in Figure 18.1.5 where you can opt to see only comments from a specific user and/or created within a certain period of time.
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Figure 18.1.5:  Options for filtering the comments displayed in a Web discussion

19 DOCUMENT ADMINISTRATION
Document Administration is performed through the CCS’s Web folder interface.  Each folder is assigned at least one Coordinator (i.e., administrator) who is responsible for granting users access, assigning the profile(s) that are to be used, and setting up the approval process (if it is an Enhanced folder).  Click the right mouse button on the folder for which you are a Coordinator, and select the Properties command from the pop-up menu as shown in Figure 19.0.1.  (All of the Web folder’s pop-up menu commands discussed in this section is also available in the File menu.)  This shows the Property dialog for the selected folder.
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Figure 19.0.1:  Administering the “ReadOnly Folder” folder

The folder is administered using the tabs of the Properties dialog, an example of which is shown in Figure 19.0.2.  The General tab allows you to specify whether the folder is an Enhanced folder (i.e., one that supports an approval process) or a Standard folder.  The Security tab is for granting users access to the folder.  The Profiles tab is for specifying what meta data can be associated with a document in this folder.  The Approval tab is for specifying the review process for approving the content of a new or modified document in this folder.
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Figure 19.0.2:  The Property dialog for administering a folder

19.1 Adding Users/Assigning Security

Select the Security tab in the Properties dialog to grant users access to a folder that you administer (see the example in Figure 19.1.1).
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Figure 19.1.1:  The Security tab for granting users access to a folder

To deny a user or group access, select its name from the User or Group list box shown in Figure 19.1.1, and push the Remove button.  

To grant a user or group access, push the Add button.  This opens the Select Users or Groups dialog shown in Figure 19.1.2 that gives the list of users and groups that can be granted access to the folder.  Select the users and groups to be given access, and push the Add button.   Finally, when the list is complete, push the OK button to close the Select Users or Groups dialog.
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Figure 19.1.2:  Dialog for selecting users and groups to be granted access to a folder

Each user and group with access to a folder must be assigned a role.  If a group is assigned a role, all users in that group are assigned the role. (The list of valid roles and their descriptions is given in Table 19.1.1.)  By default, a new user is assigned the role of Reader.  This can be changed by selecting one of the other entries in the Role dropdown list box as shown in Figure 19.1.3.
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Figure 19.1.3:  Assigning roles to users with access to a folder that you administer

Table 19.1.1:  Valid roles and their descriptions

	Role
	Description

	Reader
	A Reader can search for and read documents but cannot add them to the workspace. By default, all folder users have Read permissions. In an Enhanced folder, Readers can only view folders and published versions of documents. 

	Author
	An Author can add new documents to a folder, edit all documents in the folder, delete any document from the folder, and read all documents in the folder. In an Enhanced folder, Authors can also submit any document for publishing. 

An Author can create, rename, and delete folders. When you create a new folder, it inherits the roles and folder policies from the parent folder. However, the Author cannot change the roles or the approval policy on folders that he creates.

	Coordinator
	A Coordinator on a specific folder configures user roles on the folder. The Coordinator creates subfolders and adds, edits, and deletes documents from them. Coordinators can also read and delete a document that has been created but is not yet checked in. For Enhanced folders, the Coordinator selects the appropriate approval process. In addition, the Coordinator can undo the check out of a document or end the publishing process by using the Cancel Publishing or Bypass Approval commands
.


19.2 Setting up the Approval Process

Approval routing is an easy way to ensure that a document is adequately reviewed before it is published. When an Author chooses to publish a document, it can be routed automatically to one or more people for review before publishing it. Each of these people, called approvers, has the option of approving or rejecting the document. Approvers receive an e-mail notification when a document requires review.

You can use an approval process as a method of reviewing and approving new and updated documents in Enhanced folders before publishing them for everyone to see. After a document is approved, a new, public version is automatically created. Users who are assigned to the Reader role on that document or its folder can then search for and view the document within the CCS. If you choose not to use an approval process for a folder, the CCS publishes documents automatically upon submission without review or approval.  Figure 19.2.1 shows the Approval tab of a folder’s Properties dialog.  This is where the approval process for a folder is defined.
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Figure 19.2.1:  Specifying the review/approval process for Enhanced folder that you administer

You add users to the Approvers list by pushing the Add button shown in Figure 19.2.1 and selecting the users from the Select Users or Groups dialog in Figure 19.1.2.  You remove users from the Approvers list by selecting the user’s name and pushing the Remove button.  Push the Set E-mail button to specify the e-mail address for an approver.  Finally, selecting one of the choices for Route to approvers to specify the type of routing to be used during the approval process.  Table 19.2.1 gives more information about the meaning of each routing and approval type.  If serial routing and approval is used, then using the up-arrow and down-arrow buttons can reorder the names in the Approvers list.

Table 19.2.1:  Valid routing and approval types

	Routing and Approval Type
	Description

	One after another  (serial approval)
	The first member of the Approvers list receives a request for approval notification when the document is submitted using the Publish command. After the first person on the list approves the document, the next person on the list is asked to approve it, and so on.

The CCS publishes the document only after all approvers on the list have approved the document. If any person on the list rejects the document, the CCS cancels the approval process and returns the document to the workspace in a checked-in state.

	All at once (Parallel approval)
	As a Coordinator, you have the ability to bring an approval process to an end either by using the Bypass Approval command or the Cancel Publish command. This is useful if a document is under approval and one or more of the approvers are not available. The Bypass Approval command skips all remaining approvers and publishes the document. The Cancel Publish command cancels the approval process and returns the document to a checked-in unpublished state in the workspace.

	All approve
	When the document is submitted using the Publish command, the CCS sends a request for approval to all approvers. The e-mail notification informs approvers of the location of the document. If the required number of approvers approves the document, the CCS publishes the document. If the document does not receive the required number of approvals, the CCS cancels the approval process and returns the document to the workspace in a checked-in state.

	Only one approval required
	The option is the same as All approve except only one of the reviewers needs to approve the document for the CCS to publish it.


19.3 Assigning Document Profiles

Document profiles offer a way to add searchable information pertaining to a document. This information can help describe or identify the document more clearly. By default, a profile includes basic properties such as Author and Title. You can easily add custom properties such as Account Number or Project Manager to capture additional information that makes it easier to organize and find documents in your organization.  Figure 19.3.1 shows the Profiles tab of a folder’s Properties dialog.  From the list of available profiles, select the ones that will apply to the documents in the folder.
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Figure 19.3.1:  Specify profiles to be associated with the documents in “ReadOnly Folder” folder

Standard Folders
20 ADDING/MODIFYING DOCUMENTS (VIA WEB FOLDERS)
20.1 Standard Folders

To edit a document in a Standard folder using Web folders, simply double-click on the document’s icon or select the Open command from the File menu as shown in Figure 20.1.1.  (The entire Web folder’s File menu commands discussed is also available in the pop-up menu displayed when you click the right mouse button on a document’s icon.)  Save the document when you are finished making modifications.
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Figure 20.1.1:  Opening document for editing in a Standard folder

You can add a new document by dragging it into a Standard folder.

21 MODIFYING DOCUMENTS (VIA BROWSER)
21.1 Standard Folders:

To edit a document in a Standard folder using a browser, click with the right mouse button on the link that is the document’s title and select the Save Target As command (Save Link As if you are using Netscape) in the pop-up menu as shown in Figure 21.1.1 to save a copy of the file to your local hard drive.  
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Figure 21.1.1:  Saving the “Administrator’s Text Document” document to your local hard drive

Edit the document from your hard drive. When you are ready to update the document in its Standard folder, click its associated Show Actions link as shown in Figure 21.1.2.
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Figure 21.1.2:  Clicking the Show Actions link as part of updating the document 

Next, click on the Update File link on the Document Inspection page as shown in Figure 21.1.3.
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Figure 21.1.3:  Clicking the Update File link on the Document Inspection page 

Next, enter the path and name of the document from your hard drive that you were editing as shown in Figure 21.1.4 (If you push the Browse button, you can use the standard Windows file dialog to select the document on your hard drive.) and push the Continue button.  The file in the CCS Standard folder (the “Administrator’s folder” in this example) is then updated with the one from your local hard drive.
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Figure 21.1.4:  Entering the path/name of modified file when updating document in Standard folder

Finally, you can enter the meta
 data or profile information for the document as shown in Figure 21.1.5.  This information describes the document.
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Figure 21.1.5:  Entering profile information about the “Administrator’s Text Document” document updated in a Standard folder

22 Tips and Reminders

· Remember to use the BACK BUTTON on the browser - to navigate - the “X” will close you out if you are simply reviewing a document and want to leave it …

· A Web folder is a shortcut to a Web server.

· You can add a new document by dragging it into a Standard folder.

· Multiple versions of a document in an Enhanced folder are stored, one for each time a user changes a document
· When a comment is entered on a discussion topic, icons appear next to it.  Clicking on an [image: image110.png]


 icon allows you to reply to the comment.  Clicking an [image: image111.png]


 icon allows you to edit the comment.  Clicking an [image: image112.png]


 icon allows you to delete the comment.

· “Sharing” can be one way to have multiple users simultaneously work and collaborate on the same document.  

· Standard: Documents added to or modified in a Standard folder are immediately available to everyone with access to the folder, and only the latest version of a document is stored.  

· Enhanced: Documents added to or modified in an Enhanced folder must go through an approval process before they become available for viewing by users with read-only privileges.  These documents are immediately available to those with write privileges in the folder.  Multiple versions of a document in an Enhanced folder are stored, one for each time a user changes a document.
NOTE: Be sure to fill in each field - this will allow you to search on keywords later … and keep the historical data as to what was done by whom and when.





*See below

















� Internet Explorer 5.0 or higher is recommended.  


� meta: In computer science, a common prefix that means "about". So, for example, � HYPERLINK "http://www.pcwebopedia.com/TERM/m/metadata.html" �metadata� is data that describes other data (data about data). A metalanguage is a language used to describe other languages. A metafile is a file that contains other files. The HTML META tag is used to describe the contents of a Web page





�PAGE \# "'Page: '#'�'"  ��A coordinator at the workspace node manages content in the top-level folder and performs a set of workspace administration tasks. These tasks include managing content sources, document profiles, categories, and subscriptions, and customizing the dashboard site. The coordinator creates indexes of updated content when necessary or schedules this to occur automatically.
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